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INTRODUCTION

The EFI Fiery Color Server for Xerox DocuColor 242/252/260 media pack includes a set 
of software utilities that allow you to manage the EFI Fiery Color Server for Xerox 
DocuColor 242/252/260, as well as the print workflow and content of jobs on the EFI Fiery 
Color Server for Xerox DocuColor 242/252/260.

This document provides an overview of how to install, configure, and use the following Fiery 
Color Server utilities:

• Command WorkStation, Windows Edition

• Impose

• Command WorkStation, Macintosh Edition

• Hot Folders

• VDP Resource Manager

• WebTools
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Terminology and conventions
This document uses the following terminology and conventions.  

Term or convention Refers to

Aero Fiery Color Server (in illustrations and examples)

Copier DocuColor 242/252 and DocuColor 260

Fiery Color Server EFI Fiery Color Server for Xerox DocuColor 242/252/260

Mac OS Apple Mac OS X

Titles in italics Other documents in this set

Windows Microsoft Windows 2000, Windows XP, Windows Server 2003

Topics for which additional information is available by starting Help 
in the software

Tips and information

Important information

Important information about issues that can result in physical harm to 
you or others
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About this document
This document covers the following topics:

• Command WorkStation, Windows Edition: Monitoring and managing the print workflow 
of jobs on the Fiery Color Server.

• Impose: Applying imposition layouts to jobs for custom printing, binding, and cutting 
purposes (Windows only).

• Command WorkStation, Macintosh Edition: Monitoring and managing the print workflow 
of jobs on the Fiery Color Server.

• Remote Scan: Retrieving a scan on the copier from a remote computer on the network. 
Includes the Scan TWAIN plug-in module. 

• Hot Folders: Storing and reusing frequently used print options when printing PostScript 
and PDF files on the Fiery Color Server.

• VDP Resource Manager: Finding and deleting global objects used in variable data printing. 

• WebTools: Managing your Fiery Color Server remotely from the Internet or your 
company’s intranet.

For information about installing, configuring, and using ColorWise Pro Tools, see 
Color Printing. 

About Help

Detailed instructions on using most Fiery Color Server utilities are provided in Help. 
Wherever appropriate, this document refers you to Help for additional information and 
explains how to access Help for each utility. 
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Preparing for installation on Windows computers
Before installing Fiery Color Server software on a Windows computer, complete 
the following:

• To use Fiery Color Server user software on a Windows computer, the Sun Java file, Java 
Runtime Environment (JRE), provided in the Common Utilities folder on the User 
Software DVD, must be installed on your computer. If the correct Sun Java file is not 
installed, the Fiery User Software Installer installs it automatically before installing the 
Fiery Color Server software. 

NOTE: JRE, SE v1.5.0_01 (the recommended version) is provided on the User 
Software DVD.

• To install the Fiery Color Server software, you must have Service Pack 4 installed on a 
Windows 2000 computer, and Service Pack 2 installed on a Windows XP computer. If you 
do not, a warning message alerts you to install the Service Pack.

Different versions of Sun Java JRE can be installed on your computer. The Fiery Color Server 
software automatically finds the correct version, so you do not need to uninstall other versions 
of Sun Java JRE required for third-party applications.
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Preparing for installation on Mac OS computers
Before installing Fiery Color Server software on a Mac OS X computer, you can install 
printer fonts.

Fonts

The Fonts on the User Software DVD include screen and printer fonts that correspond to 
the 136 built-in PostScript and True Type printer fonts on the Fiery Color Server. To be 
available to applications, the screen fonts must be installed on Mac OS X.

TO INSTALL SCREEN AND PRINTER FONTS ON MAC OS X V10.3 AND V10.4

1 Insert the User Software DVD into the DVD drive of the Mac OS X computer.

2 Start the Font Book application in Applications/Font Book.

3 Choose Add Fonts from the File menu.

4 Choose User Software/OSX/Fonts/Albertus MT.

5 Choose Select All from the Edit menu.

6 Choose one of the following from Install fonts:

• For your personal use: for your use only

• For shared use: for all users of this computer

• For Classic: for Mac OS X Classic

NOTE: For Mac OS X v10.4, you must select User, Computer, or Classic Mac OS in 
Preferences/Default Install Location of Font Book beforehand.

7 Click Open.

8 Exit the Font Book application.
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Installing user software
You can install Fiery Color Server user software in the following ways:

• From the User Software DVD

• Over the network

• From the Fiery Color Server, using the Internet or intranet

If you have installed any Fiery Color Server user software previously on your computer, the 
installer will allow you to uninstall those applications during the process.

Installing user software on a Windows computer

All installation of user software on a Windows computer is done through the Fiery User 
Software Installer. The procedures below describe installing from the DVD, over the network, 
or over the Internet, and also modifying the user software. 

The only applications that are not installed by the Fiery User Software Installer are Adobe 
Acrobat and Enfocus PitStop, for use with Impose. For more information, see “Installing 
Adobe Acrobat and Enfocus PitStop” on page 48.

TO INSTALL USER SOFTWARE ON A WINDOWS COMPUTER FROM THE USER SOFTWARE DVD

1 Insert the User Software DVD into the DVD drive of your computer.

The Welcome screen of the installer appears.

2 Follow the on-screen instructions.

Do not attempt to install user software by opening the individual folders for the applications. 
Always use the Fiery User Software Installer.
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If you want to modify or remove any user software after you have installed it on your 
computer, you can do so using the User Software DVD. See the following procedure.

TO MODIFY USER SOFTWARE USING THE USER SOFTWARE DVD INSTALLER

1 Insert the User Software DVD into the DVD drive of your computer.

2 On the window that appears, select Modify, Repair, or Remove.

3 Follow the on-screen instructions.

If your computer does not have a DVD drive, you can install the user software from the Fiery 
Color Server over the network. Ask your network administrator for the IP address or the DNS 
server name of the Fiery Color Server.

You can also install the user software from the Fiery Color Server over the Internet. Ask your 
network administrator for the IP address of the Fiery Color Server.

Use your Internet browser to access WebTools. For complete information about browser and 
system requirements, see Welcome.

TO INSTALL USER SOFTWARE ON A WINDOWS COMPUTER OVER THE NETWORK 

1 Click Start, choose Run, and type either “\\IP address” or “\\DNS server name” of the 
Fiery Color Server.

2 Type the user name and password, if required.

Check with your network administrator to see if a password is required.

3 Double-click the PC_User_SW directory.

4 Double-click the Master Installer icon.

5 Follow the on-screen instructions.

TO INSTALL USER SOFTWARE ON A WINDOWS COMPUTER OVER THE INTERNET 

1 Start your Internet browser. 

2 Type the IP address or DNS name of the Fiery Color Server.

The Fiery Color Server home page appears. 

3 Click the tab for Downloads.

4 Click the link for the software that you want to install.

5 Choose Run to open the file or Save to save it to your computer.

6 If you choose Run, proceed to step 9.

7 If you choose Save, browse to the location where you want to save the USERSWMI.exe file and 
click Save.

The file is downloaded from the Fiery Color Server.
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8 Double click the USERSWMI.exe file.

9 Choose to open the file or save it to your computer.

10 Enter the Fiery Color Server URL, http://<IP address>, when asked. 

11 Follow the on-screen instructions.

For complete instructions on how to use Downloads, see Downloads Help. 

For more information about WebTools and Downloads, see WebTools.

Do not attempt to install user software by opening the individual folders for the applications. 
Always use the Fiery User Software Installer.

Installing user software on a Mac OS computer

Installation of user software on a Mac OS computer is done separately for each application. 

TO INSTALL USER SOFTWARE ON A MAC OS COMPUTER FROM THE USER SOFTWARE DVD

1 Insert the User Software DVD into the DVD drive of your computer.

2 Browse to the OSX folder.

3 Double-click the installer icon for the application that you want to install.

4 Follow the on-screen instructions.

TO INSTALL USER SOFTWARE ON A MAC OS COMPUTER OVER THE NETWORK 

1 Choose Connect to Server from the Go menu.

2 Type smb:// followed by the IP address of the Fiery Color Server, and click Connect.

If you cannot locate the Fiery Color Server, contact your network administrator.

3 Type the user name and password, if required.

Check with your network administrator to see if a password is required.

4 Select the smb shared volume that you want to connect to. 

5 Select Mac_User_SW and click OK.

6 Open the OSX folder.

7 Double-click the installer icon for the application that you want to install.

8 Follow the on-screen instructions.

You can also install the user software from the Fiery Color Server over the Internet. Ask your 
network administrator for the IP address of the Fiery Color Server.

Use your Internet browser to access WebTools. For complete information about browser and 
system requirements, see Welcome.
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TO INSTALL USER SOFTWARE ON A MAC OS COMPUTER OVER THE INTERNET 

1 Start your Internet browser. 

2 Type the IP address or DNS name of the Fiery Color Server.

The Fiery Color Server home page appears. 

3 Click the tab for Downloads.

4 Click the link for Mac OSX Client Software Installer.

The osxutils.dmg file is downloaded to your computer and a virtual disk appears on your 
desktop.

5 Follow the on-screen instructions.

For complete instructions on how to use Downloads, see Downloads Help. 

For more information about WebTools and Downloads, see WebTools.

Fiery Color Server copier touch panel
Various features are available from the Fiery Color Server copier touch panel by accessing 
pages from the following tabs:

• Main allows you to manage print connections.

• Info displays installed options on the Fiery Color Server and allows you to print system 
pages and activity logs. For more information, see Configuration and Setup.

Note: Copier options are not shown.

• Scan allows you to edit scan templates. For more information, see “Scanning from the 
copier” on page 62.

• Calibrate allows you to calibrate using ColorCal. For more information, see Color Printing.

• Setup accesses Setup options. For more information, see Configuration and Setup.

NOTE: The Fiery Color Server copier touch panel has a refresh rate of 2-3 seconds.

Main page

The Main page displays Waiting, Held, Printed, and Secure Print job queues. If you are 
logged in as Administrator or Operator, you can print, print and hold, or delete jobs in the 
Waiting, Held, and Printed queues. You can also change the number of copies to be printed. 
The Secure Print job queues can be accessed by any user who has sent a Secure Print job from 
the printer driver. You can use the Suspend Printing feature on any job. 

For more information about Secure Print, see Printing from Windows and Printing from Mac 
OS. For more information about Suspend Printing, see Configuration and Setup. 

Procedures for accessing and using the features on the Main page are provided below.
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TO ACCESS THE FIERY COLOR SERVER COPIER TOUCH PANEL

1 Press the All Services icon at the upper-right corner of the copier touch panel.

2 Press Web Applications on the copier touch panel.

The Main page is displayed.

TO MANAGE PRINT QUEUES

1 On the Main page, click a tab to access the page for that tab.

2 To manage jobs in the Waiting, Held, and Printed pages, press Login on the copier touch 
panel and log in as Administrator or Operator.

3 To page through any of the queues, press the First, Prev, Next, and Last buttons on the copier 
touch panel.

4 To delete a job, press Delete on the copier touch panel for the job.

5 To print a job, press Print on the copier touch panel for the job.

The Print page opens.

6 In the Print page, change the number of copies to be printed by typing the number in the 
Copies field.

7 Select Print, Print and Hold, or Cancel, as desired. 

8 Click More Info on the copier touch panel to open the Info page.

9 To interrupt the job that is currently printing, press Suspend Printing on the copier touch 
panel.

10 Press Resume Printing on the copier touch panel when you are ready to start the job again.
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COMMAND WORKSTATION, WINDOWS EDITION

Command WorkStation, Windows Edition allows Fiery Color Server operators (or users with 
Operator or Administrator privileges) to monitor and manage the print workflow of jobs on 
the Fiery Color Server. Command WorkStation, Windows Edition allows you to do the 
following:

• View the print status of jobs on the Fiery Color Server

• Hold, process, and print jobs

• Override user-assigned print option settings

• Preview the page content of a job

• Reorder pages in a job and combine pages from different jobs

• Create and use FreeForm master files for variable data printing

• Archive job files

• View job logs of recent print activity

Installing Command WorkStation, Windows Edition
Install Command WorkStation, Windows Edition on a Microsoft Windows computer that 
has a network connection to the Fiery Color Server. For a complete list of system 
requirements, see Welcome.

The installer for Command WorkStation, Windows Edition is provided on the User Software 
DVD. In addition to the Command WorkStation software, the installer installs the Java files 
required to use Setup from Command WorkStation. For information about using Fiery 
Setup, see Configuration and Setup.

Before you install the utility, read the guidelines described in “Preparing for installation on 
Windows computers” on page 10.

To install Command WorkStation, see “Installing user software on a Windows computer” on 
page 12.
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Configuring the connection to the Fiery Color Server
The first time you start Command WorkStation, you are prompted to configure the 
connection to the Fiery Color Server.

You can also edit the configuration whenever there is any change to your Fiery Color Server 
server or network, such as a changed server name or IP address. If you change Fiery Color 
Server Setup information, do so before you reconfigure the connection. For information 
about reconfiguring the connection, see “To modify the configuration for Command 
WorkStation, Windows Edition” on page 20.

BEFORE YOU BEGIN

• Print the Fiery Color Server Configuration page. 

For instructions on printing the Configuration page, see Configuration and Setup.

This page contains information you need when configuring the connection, such as the IP 
address of the Fiery Color Server. For TCP/IP installations, you can use the DNS name 
instead of the IP address. Make sure the Fiery Color Server is already registered in a Domain 
Name Server (DNS) on your network. For more information, contact your network 
administrator. 

TO CONFIGURE THE CONNECTION FOR COMMAND WORKSTATION, WINDOWS EDITION

1 Choose Start  >  Programs  >  Fiery  >  Command WorkStation to start the utility.

The Available Servers dialog box appears and displays all servers found in the local subnet. 
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2 If no Fiery Color Servers were found, click the Manual tab to search by DNS name or IP 
address. Type the DNS name or IP address and click Add to add the server to the Available 
Servers list.

If no Fiery Color Servers were found by Manual search, click the Auto Search tab, and then 
click Advanced to search by a range of IP addresses or by the IP address and subnet mask. 

All available servers appear in the Available Servers list.

3 Select the Fiery Color Server that you want to use and click Add.

The selected Fiery Color Server is added to the Login Server window.
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4 Click the button to the left of the server name.

The Login dialog box appears.

5 Click the key to the left of Administrator, Operator, or Guest and type the appropriate 
password, if required.

6 Click Log In.

For information about setting passwords and the default Administrator password for the Fiery 
Color Server, see Configuration and Setup.

Command WorkStation is now connected to the Fiery Color Server.

TO MODIFY THE CONFIGURATION FOR COMMAND WORKSTATION, WINDOWS EDITION

1 Start Command WorkStation.

The Login Server window appears.

2 Select the Fiery Color Server for which you want to modify the configuration and 
click Remove.

3 Repeat “To configure the connection for Command WorkStation, Windows Edition” on 
page 18.
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Using Command WorkStation, Windows Edition
After you install and configure Command WorkStation, you can begin using it to monitor 
and manage jobs on the Fiery Color Server. 

For complete instructions on using the standard Command WorkStation features, see 
Command WorkStation Help. Additional features are described in the sections starting on 
page 22. Additional production features are described in Production Features.

TO ACCESS COMMAND WORKSTATION HELP

1 Start Command WorkStation.

Select the Fiery Color Server from the Server List dialog box and log in to the server.

For information about setting passwords and the default Administrator password for the Fiery 
Color Server, see Configuration and Setup. 

2 Choose Help from the Help menu.
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Additional features
The following sections describe how to use additional features of Command WorkStation that 
are not discussed in Command WorkStation Help.

User Authentication

If user authentication has been enabled in Fiery Color Server Setup, users may have to enter 
a user name and password in the printer driver to send a job to the Fiery Color Server. 
Management of the job in Command WorkStation is determined by how you have logged on 
to the Fiery Color Server, as Administrator, Operator, or Guest.

For information about setting up Users and Groups and enabling user authentication in the 
Configure WebTool, see Configuration and Setup. For information about User Authentication 
in the printer driver, see Print Options.

Align Trays

The Align Trays feature allows you to adjust the placement of text and images on the page so 
they are correctly aligned on a sheet of paper. This ensures that both sides of a duplex sheet 
have exactly the same alignment.

You can also perform tray alignment from the Fiery Color Server copier touch panel.

To perform tray alignment, you must do the following:

• Log in to the Fiery Color Server with Administrator privileges and enable tray alignment 
in Fiery Color Server Setup.

• Enable Tray Alignment in the Media area of the Fiery Color Server printer driver.

• Select the correct paper tray before printing.

NOTE: For Tray Alignment to work when printing a job, select the tray that you have aligned 
in the Media area before printing. If you later print a job using the auto tray selection, the 
alignment does not work. 

TO ALIGN PAGES FOR PRINTING

1 In the Active Jobs window, select the connected Fiery Color Server for which you want to 
perform tray alignment.

If the Active Jobs window is hidden, choose Active Jobs from the Window menu to display it.

2 Choose Align Trays from the Server menu.
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A dialog box containing the Tray Alignment options appears.

3 Choose the tray that you want to align from the Tray menu.

4 Choose the paper size loaded in the tray from the Media menu.

NOTE: The alignment is specific to the combination of tray and paper size specified. If you 
align a given tray with Letter paper, and then load Legal paper in that tray, the alignment is 
wrong. You must perform a new alignment for each combination of tray and paper size.

5 In the Print Alignment Page area, select the Print duplex option to print a duplex page, or 
clear the option to print a single-sided page.

6 Click Print.

7 After the Alignment Page is printed, follow the instructions on the page. 

Fold the page exactly in half horizontally, unfold it, and then fold it in half vertically. When 
you unfold the sheet, observe that the fold lines cross three scales on three sides of the page. 
Determine which number on the scale each fold line crosses.

8 In the Enter alignment values area, enter the value that appears where the fold crosses each 
of the three scales, marked A, B, and C, for Side 1. If you choose to align for duplex printing, 
enter the values for the three scales on Side 2 of the page as well.

NOTE: If you enter different values in A and C, the image rotates, leading to uneven areas on 
printed output. If this occurs, enter the same value in A and C.

9 After you have entered the alignment values, click Apply, and then click Check Alignment to 
print the new alignment page. 

10 To remove the alignments, select a tray and click Defaults in the Enter alignment values area.

11 Click Done.
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Mixed Media

The Mixed Media feature allows you to define the chapter divisions of a job, print ranges of 
pages on varying types of media, insert blank media between pages, and insert tab media 
containing text labels.

The following guidelines and restrictions apply to Mixed Media settings:

• The Mixed Media dialog box restricts you from specifying settings that conflict with 
any media, page size, or finishing settings that have been specified for the job in the 
Job Properties dialog box or printer driver. 

• When two or more Mixed Media settings are in conflict with each other, the Mixed Media 
dialog box highlights the setting names in red, signaling you to resolve the conflict.

• When you specify print options (in the Job Properties dialog box or printer driver) after 
specifying Mixed Media settings, certain print options may conflict with the page-specific 
Mixed Media settings. You must resolve the conflict by choosing different print options or 
removing certain Mixed Media specifications.

• Mixed Media settings affect the use of output color profiles when the “Use media defined 
profile” option is selected in ColorWise Pro Tools. For more information, see Color 
Printing.

• If counters are configured for the copier, blank media inserted between pages count as 
printed pages.

Basic instructions for accessing and using Mixed Media are provided in Command 
WorkStation Help. Features specific to the Fiery Color Server are described in the following 
procedures.
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TO DEFINE MIXED MEDIA SPECIFICATIONS

1 Select or right-click a spooled/held job in the Active Jobs window and choose Properties from 
the Actions menu or double-click a job.

2 Click the Media icon and scroll down to Mixed Media.

The Mixed Media dialog box lists any previously defined media settings and includes buttons 
for defining, modifying, and removing settings.

3 For Chapter Start Page(s), type the page numbers on which you want to start new chapter 
sections.

Type page numbers as comma-separated values (for example: 4,9,17) to designate the start of 
each new chapter. This feature forces each starting page to use a right-side page, adding a 
preceding left-sided blank, if required. 

NOTE: It is not necessary to type the first page. Page numbers refer to the numbering of the 
original document. If you use the Chapter Start Page(s) feature, all media specified in the 
Paper menu per chapter must share the same dimensions (for example, all Letter, all Tabloid, 
or all A4). 

4 To apply finishing options (for example, stapling or sorting) to each chapter created using 
the Chapter Start feature, select the “Define Each Chapter As A Separate Finishing Set” 
option.

NOTE: You can use the Define Each Chapter As A Separate Finishing Set function to define 
subset finishing styles when the finishing style is the same for the entire set. For example, if 
you specify stapling with a 10-page document with Chapter Start Page(s) as 3,6, the pages are 
divided into 1–2, 3–5 and 6–10 groups and each group is stapled. You can also use Chapter 
subsets to specify Multi-Center Fold and Fold and Staple finishing options.

NOTE: Not all finishing options can be applied to chapters that contain mixed sizes of media 
(for example, Letter and A4).

5 To define properties for front and back covers, click Define Cover. 

For more information, see “To define cover media settings” on page 26.
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6 To define properties for individual pages or page ranges, click New Page Range.

For more information, see “To define media for specific pages” on page 27.

7 To insert tab media, click New Tab.

The Insert Tab dialog box appears. For information about defining tab settings, see page 28.

NOTE: The Insert Tab feature is not available for imposed jobs.

8 To insert blank pages, click New Insert.

For more information, see “To insert blank pages” on page 28.

9 To modify or delete a current definition, select it in the Mixed Media Definition list, and click 
Edit or Remove.

If you click Edit, enter new settings for the definition and click Modify.

10 After you finish defining Mixed Media settings, click OK to close the Mixed Media dialog box 
and Job Properties.

The Mixed Media settings are applied to the job.

NOTE: You can save up to 100 different settings for the Selection list in the Mixed Media 
dialog box.

TO DEFINE COVER MEDIA SETTINGS

1 In the Mixed Media dialog box, click Define Cover.

The Cover Media dialog box appears.
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2 To define identical front cover and back cover media, select the “Apply the same settings for 
both front and back cover” option. To define media settings for the front or back cover 
individually, select the Front Cover or Back Cover option.

3 Select your desired media from the Paper Catalog drop-down menu.

4 You can also click Select to open the Paper Catalog window, select your desired media, and 
click OK.

For more information about Paper Catalog, see “Paper Catalog” on page 31.

5 Click OK to return to the Mixed Media dialog box.

Cover Media settings take precedence over settings defined in the Page/Page Range Media 
dialog box.

TO DEFINE MEDIA FOR SPECIFIC PAGES

1 In the Mixed Media dialog box, click New Page Range.

The Page/Page Range Media dialog box appears.

2 Type pages and page ranges as comma-separated values (for example: 3,9–14,18).

3 Specify other settings, as required.

If you assign a new media type to the back side of a duplexed sheet, a blank page is inserted to 
force the assigned page content to the front side of the next sheet.

4 Select your desired media from the Paper Catalog drop-down menu.

5 You can also click Select to open the Paper Catalog window, select your desired media, and 
click OK.

For more information about Paper Catalog, see “Paper Catalog” on page 31.

6 Click Add Definition after each media setting you define. 

7 Click Close to return to the Mixed Media dialog box.
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TO INSERT BLANK PAGES

1 In the Mixed Media dialog box, click New Insert.

The Insert Blank dialog box appears.

2 Indicate whether to insert the blank before or after the target page. Define the target page as 
either the first or last page in the document, or as a specific numbered page.

3 Specify other settings as required for the blank page.

4 Select your desired media from the Paper Catalog drop-down menu.

5 You can also click Select to open the Paper Catalog window, select your desired media, and 
click OK.

For more information about Paper Catalog, see “Paper Catalog” on page 31.

6 Click Insert after each blank page you define.

7 Click Close to return to the Mixed Media dialog box.

Insert Tabs

The Insert Tabs feature allows you to automatically insert tab pages throughout a job. This 
feature accommodates various sizes and types of tab media stock. Users can insert the tab text 
and override text attributes on a per-job basis.

NOTE: The Insert Tabs feature is not available for imposed jobs.

NOTE: When you configure counters for the copier, printed tab pages count as black-and-
white pages, provided colors are calibrated to use pure black toner. Expelled tabs are not 
counted as printed pages.

TO INSERT TAB PAGES

1 Select or right-click a spooled/held job in the Active Jobs window and choose Properties from 
the Actions menu or double-click a job.

2 Click the Media icon and scroll down to Mixed Media.
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3 In the Mixed Media dialog box, click New Tab.

The Insert Tab dialog box appears. 

4 Enter the number of tab positions included in a complete tab set in the “Number of tabs in a 
set” field.

This specification ensures that tab text is printed in the correct tab positions. For example, tab 
positions in a set consisting of ten tabs are distinct from tab positions in a set consisting of five 
tabs. 

5 Specify media type, paper source, and paper size settings for the tab stock.

Paper Size values refer to the dimensions of the stock, including the tabbed portion.

NOTE: Neither the Fiery Color Server nor the copier can recognize the tab positions. You 
must create documents and select items so that the print image is not positioned outside the 
tab area.

6 Select your desired media from the Paper Catalog drop-down menu.

7 You can also click Select to open the Paper Catalog window, select your desired media, and 
click OK.

For more information about Paper Catalog, see “Paper Catalog” on page 31.
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8 To specify attributes for the tab text, enter the number of tabs in the “Number of tabs to 
insert” field and click Insert. 

9 If you want all tabs to use the same text attributes, select “Apply the same text attributes for 
all tabs”. 

10 In the Text Attributes area, click the arrows to display the menus for font, size, text rotation, 
and text alignment, and select the attributes you want from each menu. 

11 Indicate where you want each tab inserted in the document.

• In the Page field, type the page number where you want the tab inserted.

• Select Before to insert the tab before the page number or click to clear the checkbox.

NOTE: If you define a tab to be inserted between an odd-numbered page and an even-
numbered page in a duplex job, the tab is inserted after the odd-numbered page on the first 
sheet, and the even-numbered page is printed on the next sheet.

12 Enter the desired tab text for each tab in the Tab Text field.

If desired, specify individual text attributes for each tab individually.

13 After you finish specifying tab text, click OK to close the Insert Tab dialog box.

The Mixed Media dialog box displays the current tab settings in the Mixed Media 
definition list.

14 To modify media settings for the tabs, select the tab description in the Mixed Media 
definition list, and click Edit.

15 To apply your Insert Tab settings to the document, click OK to close the Mixed Media dialog 
box and Job Properties.
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Paper Catalog

Paper Catalog is a system-based paper warehouse database, which stores attributes of any 
media available for printing from the Fiery Color Server. You can then select media from 
those listed for your job.

You can access Paper Catalog in a number of different ways from the following interfaces:

• Command WorkStation

• Mixed Media Setup

• Job Properties

• Hot Folders

• Printer driver (see Print Options)

The following sections describe how to access and use Paper Catalog from each of these 
interfaces.

TO ACCESS PAPER CATALOG FROM COMMAND WORKSTATION

• To open Paper Catalog from Command WorkStation, select a spooled/held job in the Active 
Jobs window and choose Paper Catalog from the Server menu.

For information about using Paper Catalog, open Paper Catalog Help from the Paper Catalog 
Help menu or press the F1 key on your keyboard. Only administrators can configure and edit 
Paper Catalog entries and settings.

TO ACCESS PAPER CATALOG FROM JOB PROPERTIES

1 Select a spooled/held job in the Active Jobs window and choose Properties from the 
Command WorkStation Actions menu. 

2 In the Job Properties dialog box, click the Media icon, and then select your desired media 
from the Paper Catalog drop-down menu.

3 You can also click Details to open the Paper Catalog window, select your desired media, and 
click OK.

4 Click OK in the Job Properties window.

The media you have selected appears in the Paper Size field in the Media area.

TO ACCESS PAPER CATALOG FROM HOT FOLDERS

1 In the Folder Properties dialog box, select Job Settings and click Define.

2 In the Job Properties dialog box, click the Media icon, and then select your desired media 
from the Paper Catalog drop-down menu.

3 You can also click Details to open the Paper Catalog window, select your desired media, and 
click OK.

4 Click OK to return to the Hot Folders Properties window.
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Tray and Paper Association
Tray and Paper Association is a feature available from Command WorkStation that allows you 
to assign a print engine tray with a paper catalog entry. Use this feature to allow the print 
engine to automatically pull specific paper catalog assigned media for a job that uses a 
particular paper catalog entry.

Assigning media to a tray

When you load media on your print engine, use Tray and Paper Association to define the 
media assigned to your print engine trays.

Paper Catalog filters the entries shown for each tray by the paper attributes reported from the 
Print Server. 

TO ASSIGN MEDIA TO A TRAY

1 In the main Command WorkStation window, choose Server > Paper/Tray Association.

If you are logged on as an administrator, you can also go to Server > Paper Catalog > Tools > 
Paper/Tray Association.

All installed trays are displayed in the main Tray and Paper Association window. 

2 Place your cursor over a tray to display the tray association details. An unassigned tray 
displays “unassigned”. A tray that is assigned displays a summary of the paper catalog entry.

3 Click a tray from the list on the left.

All available entries are listed for that tray. If the tray does not recognize any paper catalog 
information, the entire paper catalog list is displayed. 

4 Select one paper catalog entry.

5 Click OK.

Monitoring media status in a tray

If your print engine supports reporting media levels in each tray, you can check the status 
from the Tray and Paper Association window.

TO MONITOR MEDIA STATUS IN A TRAY

1 In the main Command WorkStation window, choose Server > Paper/Tray Association.

Each tray displays a percentage amount of the media loaded.

2 Click Cancel to close out of the window and not apply any Tray and Paper Association changes.
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Troubleshooting: Job prints with wrong media
Check to make sure that the correct Paper Catalog entry is associated with the correct print 
engine tray.

If a Paper Catalog entry associated with a tray is not updated when the media in the tray is 
changed, the job prints with the loaded media.

Check to make sure that the desired paper catalog entry assigned to your job has not been 
deleted.

Virtual Printers

Virtual printers give users a method of printing to the Fiery Color Server using predefined 
settings to configure the print job. The Fiery Color Server administrator can create virtual 
printers and publish them so that users can access them on the network. The SMB, LPR and 
FTP services are supported.

NOTE: By default, three virtual printers are already set up to correspond to the print, hold, and 
direct queues. These virtual printers cannot be modified.

The administrator specifies job settings for the virtual printer. The administrator can apply an 
imposition template to a virtual printer. Imposition settings override job property settings.

The Fiery Color Server administrator can view the available virtual printers and published 
queues, publish a virtual printer, and delete, duplicate, or edit a virtual printer.

To configure virtual printers, you must be logged on with Administrator privileges.

TO CONFIGURE A VIRTUAL PRINTER

1 In the Command WorkStation Server menu, choose Virtual Printers.

2 Click New.

3 Specify the following:

• Virtual Printer Name: Type an alphanumeric name.

• Comments: Add comments to help define the virtual printer for the user, for example, 
“duplex company brochure.”

• Printing: Select one of the standard Fiery Color Server actions available from Command 
WorkStation, including Hold, Process and Hold, Print, and Print and Hold.

• Use Custom Job Properties: Access and choose Job Properties.

• Apply Imposition Settings: Access and choose Impose settings.

4 Click OK.
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TO MANAGE VIRTUAL PRINTERS

1 Choose Server > Virtual Printers.

2 Select a virtual printer in the list and click Edit, Duplicate, or Delete.

NOTE: Once a virtual printer has been created, its name cannot be changed, although the 
print settings can be changed.

Printing to a virtual printer using SMB

Virtual printers are published on the network. To print to a published virtual printer from a 
client computer over SMB, do the following:

TO PRINT TO A VIRTUAL PRINTER USING SMB

1 Right-click Network Neighborhood or My Network Places, and select Find Computer or Search 
for Computers.

2 Type the name of the Fiery Color Server that you are looking for and click Search Now.

If you cannot locate the Fiery Color Server, contact your network administrator.

3 Double-click the name of the Fiery Color Server to display published virtual printers.

4 Double-click the virtual printer that you want to connect to.

You must install the printer driver from the User Software DVD as described in Printing from 
Windows.

The virtual printer appears in Settings  >  Printers and Faxes.

Printing to a virtual printer using LPR on Windows
To print to a virtual printer from a client computer using an LPR connection on Windows, 
you must configure a standard TCP/IP port for LPR printing and install the Fiery Color 
Server printer drivers. When you configure the port, select LPR for the protocol and type the 
name of the virtual printer for the queue name.

For information, see Printing from Windows. 

Printing to a virtual printer using LPR on Mac OS
To print to a virtual printer from a client computer using an LPR connection on Mac OS, 
follow the instructions for setting up the Fiery Color Server on Mac OS X using IP printing. 
For Queue Name, enter the name of the virtual printer.

For information, see Printing from Mac OS. 
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PRINTING TO A VIRTUAL PRINTER USING FTP

If the administrator has enabled FTP services, the Fiery Color Server can function as an FTP 
server. For information about Setup, see WebTools Configure Help.

To print to a virtual printer using FTP, use your FTP client software and connect to the Fiery 
Color Server as to any FTP server. Ask your network administrator for the following 
information:

• IP address or DNS name of the Fiery Color Server

• User name and password, if required

• The name of the virtual printer

For more information about FTP printing, see Printing from Windows and Printing from 
Mac OS.

Troubleshooting
When troubleshooting basic connection and software problems with Command 
WorkStation, see the following sections. For additional troubleshooting information, see 
Command WorkStation Help.

Command WorkStation cannot connect to the Fiery Color Server

If you cannot connect to the Fiery Color Server or locate the Fiery Color Server from your 
computer, contact the network administrator. The administrator may need to troubleshoot 
your network connections and check settings on the servers that you print to. If settings have 
changed, it may be necessary to reconfigure the Fiery Color Server (see Configuration and 
Setup).

If you can connect to the Fiery Color Server with another utility, you may need to reconfigure 
the Command WorkStation connection to the Fiery Color Server (see page 18).

If you configured the Fiery Color Server and set up client computers and network servers 
according to the instructions in Configuration and Setup, print a Test Page. If you can print 
the Test Page but still cannot print a document from a remote computer, contact your 
network administrator to troubleshoot the network connection.

If you cannot connect and cannot print a Test Page, check the copier touch panel for error 
information.
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Command WorkStation does not respond

If Command WorkStation is unresponsive, use the following troubleshooting guidelines.

IF THE COMMAND WORKSTATION WINDOWS DO NOT UPDATE

1 Log off and then quit Command WorkStation. 

2 Restart Command WorkStation or restart the computer. 

If the Command WorkStation windows do not update or no jobs are displayed, and the 
mouse has no effect (you cannot select a job or a window, use a right mouse command, or 
select a menu item), the Fiery Color Server is offline or network communication has failed.

TO FORCE AN EXIT FROM COMMAND WORKSTATION

1 Press Ctrl-Alt-Delete and use the Program Manager to close Command WorkStation. 

2 At the Fiery Color Server, disconnect and reconnect the network cable, and then try printing a 
Test Page or Configuration page.

3 If printing fails, restart the Fiery Color Server.
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COMMAND WORKSTATION, MACINTOSH EDITION

Command WorkStation, Macintosh Edition allows operators of the Fiery Color Server, or 
users with Operator or Administrator privileges, to monitor and manage the print workflow 
of jobs on the Fiery Color Server. 

Command WorkStation, Macintosh Edition, enables you to do the following:

• View the print status of jobs on the Fiery Color Server

• Hold, process, and print jobs

• Override user-assigned print option settings

• Preview the page content of a job

• Create and use FreeForm master files for variable data printing

• Archive job files

• View job logs of recent print activity
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Installing Command WorkStation, Macintosh Edition
Install Command WorkStation, Macintosh Edition on a Mac OS X computer that has a 
network connection to the Fiery Color Server. For complete system requirements, see 
Welcome.

Before installing the utility, complete the preliminary procedures described in “Preparing for 
installation on Mac OS computers” on page 11.

To install Command WorkStation, Macintosh Edition, see “Installing user software on a Mac 
OS computer” on page 14.

Configuring the connection to the Fiery Color Server
The first time you start Command WorkStation, you are prompted to configure the 
connection to the Fiery Color Server.

You can also edit the configuration whenever there is any change to your Fiery Color Server 
server or network, such as a changed server name or IP address. If you change Fiery Color 
Server Setup information, do so before you reconfigure the connection.

BEFORE YOU BEGIN

• Print the Fiery Color Server Configuration page. 

For instructions on printing the Configuration page, see Configuration and Setup.

This page contains information you need when configuring the connection, such as the IP 
address of the Fiery Color Server. For TCP/IP installations, you can use the DNS name 
instead of the IP address. Make sure that the Fiery Color Server is already registered in a 
Domain Name Server (DNS) on your network. For more information, see the 
documentation that accompanies your network system. 
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TO CONFIGURE THE CONNECTION FOR COMMAND WORKSTATION, MACINTOSH EDITION

1 Open the Applications : Fiery : CWS Macintosh Edition folder on the Mac OS X hard disk. 
Double-click the CWS Macintosh Edition file to start the application.

The Available Servers dialog box appears. All servers found in the local subnet are displayed.

2 If no Fiery Color Servers were found, click the Manual tab to search by DNS name or IP 
address. Click Add to add the server to the Available Servers list.

If no Fiery Color Servers were found in the Manual search, click the Auto Search tab, and then 
click Advanced to search by a range of IP addresses or the IP address and subnet mask. 

All available servers are displayed in the Available Servers list.
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3 Select the Fiery Color Server that you want to use and click Add.

The selected Fiery Color Server is displayed in the Server List dialog box.

4 Click the server name to select it, and then click the key or the Login button.

The Login dialog box appears.

5 Select Administrator, Operator, or Guest, type the password next to the key, and then 
click Login.

Your computer is connected to the server.

For more information about setting passwords and the default Administrator password for the 
Fiery Color Server, see Configuration and Setup.

To modify the Command WorkStation connection to the Fiery Color Server, you must 
remove the server from the Login Server list and follow the procedure for configuring the 
connection.
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Using Command WorkStation, Macintosh Edition
After you install and configure Command WorkStation, you can begin using it to monitor 
and manage jobs on the Fiery Color Server. 

Complete instructions on how to use the Command WorkStation features are provided in 
Command WorkStation Help. 

TO ACCESS COMMAND WORKSTATION HELP

1 Start Command WorkStation.

Select the Fiery Color Server in the server list, and log in to the server.

For more information about setting passwords and the default Administrator password for 
the Fiery Color Server, see Configuration and Setup.

2 Choose Help from the CWS menu.



COMMAND WORKSTATION, MACINTOSH EDITION 42
Additional Features
The following sections describe how to use additional features of Command WorkStation 
that are not discussed in Command WorkStation Help.

User Authentication

If user authentication has been enabled in Fiery Color Server Setup, users may need to enter a 
user name and password in the printer driver to send a job to the Fiery Color Server. 
Management of the job in Command WorkStation is determined by how you have logged on 
to the Fiery Color Server, as Administrator, Operator, or Guest.

For information about setting up Users and Groups and enabling user authentication in 
the Configure WebTool, see Configuration and Setup. For information about User 
Authentication in the printer driver, see Print Options.

Mixed Media

The Mixed Media feature allows you to define the chapter divisions of a job, print ranges of 
pages on varying types of media, insert blank media between pages, and insert tab media 
containing text labels.

The following guidelines and restrictions apply to Mixed Media settings:

• The Mixed Media dialog box restricts you from specifying settings that conflict with any 
media, page size, or finishing settings that have been specified for the job in the Job 
Properties dialog box or printer driver.

• When two or more Mixed Media settings are in conflict with each other, the Mixed Media 
dialog box highlights the setting names in red, signaling you to resolve the conflict.

• When you specify print options (in the Job Properties dialog box or printer driver) after 
specifying Mixed Media settings, certain print options may conflict with the page-specific 
Mixed Media settings. You must resolve the conflict by choosing different print options or 
removing certain Mixed Media specifications.

• If counters are configured for the copier/printer, blank media inserted between pages 
count as printed pages.

Features specific to the Fiery Color Server are described in the following procedures.

NOTE: The procedures for defining Mixed Media settings in Command WorkStation, 
Windows Edition are similar to those in Command WorkStation, Macintosh Edition, but 
include illustrations. For information, see page 24.
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TO DEFINE MIXED MEDIA SPECIFICATIONS

1 Select or right-click a spooled/held job in the Active Jobs window and choose Properties from 
the Actions menu, or double-click a job.

2 Click the Media icon and scroll down to Mixed Media.

The Mixed Media dialog box lists any previously defined media settings and includes buttons 
for defining, modifying, and removing settings.

3 For Chapter Start Page(s), type the page numbers on which you want to start new chapter 
sections.

Type page numbers as comma-separated values (for example: 4,9,17) to designate the start of 
each new chapter. This feature forces each starting page to use a right-side page, adding a 
preceding left-sided blank, if required. 

NOTE: It is not necessary to type the first page. Page numbers refer to the numbering of the 
original document. If you use the Chapter Start Page(s) feature, all media specified in the 
Paper menu per chapter must share the same dimensions (for example, all Letter, all Tabloid, 
or all A4).

4 To apply finishing options (for example, stapling or sorting) to each chapter created using 
the Chapter Start feature, select the “Define Each Chapter As A Separate Finishing Set” 
option.

NOTE: Not all finishing options can be applied to chapters that contain mixed sizes of media 
(for example, Letter and A4).

5 To define properties for front and back covers, click Define Cover. 

For more information, see “To define cover media settings” on page 44.

6 To define properties for individual pages or page ranges, click New Page Range.

For more information, see “To define media for specific pages” on page 44.

7 To insert tab media, click New Tab.

The Insert Tab dialog box appears. For information about defining tab settings, see page 28.

NOTE: The Insert Tab feature is not available for imposed jobs.

8 To insert blank pages, click New Insert.

For more information, see “To insert blank pages” on page 45.

9 To modify or delete a current definition, select it in the Mixed Media Definition list, and click 
Edit or Remove.

If you click Edit, enter new settings for the definition and click Modify.

10 After you finish defining Mixed Media settings, click OK to close the Mixed Media dialog box 
and Job Properties.

The Mixed Media settings are applied to the job.
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NOTE: You can save up to 100 different settings for the Selection list in the Mixed Media 
dialog box.

TO DEFINE COVER MEDIA SETTINGS

1 In the Mixed Media dialog box, click Define Cover.

The Cover Media dialog box appears.

2 To define identical front cover and back cover media, select the “Apply the same settings for 
both front and back cover” option. To define media settings for the front or back cover 
individually, select the Front Cover or Back Cover option.

3 Specify other settings as required.

4 For Cover Page Mode, define how you want the content printed on the cover. You can specify 
printing on the front side only, back side only, or both sides of the cover page.

The following restrictions apply to Cover Page Mode settings:

• If you specify Print on Front Only, you must set the Duplex setting to Off.

• If you specify Print on Back Only or Print on Both Sides, you must set the Duplex setting 
to either Head to Head or Head to Toe. The Duplex setting determines the orientation of 
the cover content.

5 Select your desired media from the Paper Catalog drop-down menu.

6 You can also click Select to open the Paper Catalog window, select your desired media, and 
click OK.

The media you have selected appears beside Paper Name in the main Cover Media window.

For more information about Paper Catalog, see “Reorder Jobs” on page 53.

7 Click OK to return to the Mixed Media dialog box.

Cover Media settings take precedence over settings defined in the Page/Page Range Media 
dialog box.

TO DEFINE MEDIA FOR SPECIFIC PAGES

1 In the Mixed Media dialog box, click New Page Range.

The Page/Page Range Media dialog box appears.

2 Type pages and page ranges as comma-separated values (for example: 3,9–14,18).

3 Specify other settings, as required.

If you assign a new media type to the back side of a duplexed sheet, a blank page is inserted to 
force the assigned page content to the front side of the next sheet.

4 Select your desired media from the Paper Catalog drop-down menu.
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5 You can also click Select to open the Paper Catalog window, select your desired media, and 
click OK.

The media you have selected appears beside Paper Name in the main Page Range window.

For more information about Paper Catalog, see “Reorder Jobs” on page 53.

6 Click Add Definition after each media setting you define. 

7 Click Close to return to the Mixed Media dialog box.

TO INSERT BLANK PAGES

1 In the Mixed Media dialog box, click New Insert.

The Insert Blank dialog box appears.

2 Indicate whether to insert the blank before or after the target page. Define the target page 
as either the first or last page in the document, or as a specific numbered page.

3 Specify other settings, as required, for the blank page.

4 Select your desired media from the Paper Catalog drop-down menu.

5 You can also click Select to open the Paper Catalog window, select your desired media, and 
click OK.

The media you have selected appears beside Paper Name in the main Insert Blank window.

For more information about Paper Catalog, see “Reorder Jobs” on page 53.

6 Click Insert after each blank page you define.

7 Click Close to return to the Mixed Media dialog box.

Schedule Printing

The Schedule Printing feature allows you to set a specific date and time for printing a job. 
Assign Schedule Printing settings to a job from the following areas:

• Job Properties window in Command WorkStation, Macintosh Edition

• Active Jobs window in Command WorkStation, Macintosh Edition

For more information, see “Schedule Printing” on page 54.
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Troubleshooting
When troubleshooting basic connection and software problems with Command 
WorkStation, see the following sections. For additional troubleshooting information, see 
Command WorkStation Help.

Command WorkStation cannot connect to the Fiery Color Server

If you cannot connect to the Fiery Color Server or locate the Fiery Color Server from your 
computer, contact the network administrator. The administrator may need to troubleshoot 
your network connection and check settings on the servers that you print to. If settings have 
changed, it may be necessary to reconfigure the Fiery Color Server.

If you are able to connect to the Fiery Color Server with another utility, you may need to 
reconfigure the Command WorkStation connection to the Fiery Color Server (see page 38).

If you configured the Fiery Color Server and set up client computers and network servers 
according to the instructions in Configuration and Setup, print a Test Page. If you can print 
the Test Page but still cannot print a document from a remote computer, contact your 
network administrator to troubleshoot the network connection.

If you cannot connect and cannot print a Test Page, check the copier touch panel for error 
information.

Command WorkStation does not respond

If Command WorkStation is unresponsive, use the following troubleshooting guidelines.

IF THE COMMAND WORKSTATION WINDOWS DO NOT UPDATE

1 Log off and then quit Command WorkStation. 

2 Restart Command WorkStation or restart the computer. 

If the Command WorkStation windows do not update, or no jobs are displayed, and the 
mouse has no effect (you cannot select a job or a window, use a Control-click command, or 
select a menu item), the Fiery Color Server is offline or network communication has failed.

TO FORCE AN EXIT FROM COMMAND WORKSTATION

1 Press Command-Option-Escape and use the Force Quit Applications dialog box to close 
Command WorkStation. 

2 At the Fiery Color Server, disconnect and reconnect the network cable, and then try printing a 
Test Page or Configuration page.

3 If printing fails, restart the Fiery Color Server.
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IMPOSE

Impose is a utility (available as an option) that you access from Command WorkStation, 
Windows Edition. Impose allows you to do the following:

• Apply imposition layouts to jobs for custom printing, binding, and cutting

• Apply impositions to variable data jobs

• Save the imposed jobs as PDF files

Installing and enabling Impose
The following sections describe how to install and enable Impose.

Installing Impose

The Impose software is automatically installed when you install Command WorkStation, 
Windows Edition from the User Software DVD. 

Do not attempt to install Impose manually from the User Software DVD (by starting the 
setup.exe from the Impose folder). It is automatically installed when you install Command 
WorkStation. Installing Impose separately from Command WorkStation can cause 
unpredictable results. 

To enable Impose on a client computer, you must:

• Install Adobe Acrobat and Enfocus PitStop Professional.

NOTE: The Adobe Acrobat/Enfocus PitStop DVD is provided in the Impose Media Pack.

• Install the Impose software protection key (dongle) into the correct port of the 
client computer.

If you see a dongle installed on the computer, Impose has already been enabled and is ready 
for use. If the dongle is not installed, see the documentation that is provided in the Impose 
kit. Without a dongle installed, you can use Impose in Demo mode. Demo mode allows you 
to impose documents and save them, but all printed output displays a “Demo” watermark.

NOTE: The protection key (dongle) may be either a parallel port type or a USB type dongle. 
For more information, see the documentation that is provided in the Impose kit.
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Installing Adobe Acrobat and Enfocus PitStop

To use Impose, you must install the Acrobat and the PitStop Professional plug-in for Acrobat 
for use with Impose from the installer DVD provided in your Impose kit. Impose is installed 
when you install Command WorkStation, and is accessed from Command WorkStation. 

NOTE: If you install Acrobat after Command WorkStation, you may need to restart 
Command WorkStation in order to use Impose. 

Instructions are provided in your Impose kit for installing Acrobat and PitStop Professional. 
We recommend that you follow those instructions.

We recommend that you install the version of Acrobat provided in your Impose kit and 
remove any other versions of Acrobat installed on your computer.

TO INSTALL THE PDF SUPPORT APPLICATIONS

1 Uninstall all versions of Acrobat that are currently installed on the computer.

• Close all open applications.

• Follow the Windows instructions for removing programs.

Make sure to delete not only the main folder for the application but also the associated 
Acrobat folder located, by default, in C:\Program Files\Common Files\Adobe. (The exact 
drive letter may vary, depending on the computer.)

2 Restart the computer after you finish uninstalling earlier versions of Acrobat.

3 Close all software applications that are currently running on the computer.

4 Insert the Adobe Acrobat/Enfocus PitStop DVD into the DVD drive.

5 If the installer does not start automatically, browse to the location of the DVD drive and 
double-click the PDF_Applications icon.

6 At the message reminding you to close all applications, click Yes.

7 At the next installation screen, make sure “Adobe Acrobat” and “PitStop” are both selected, 
and then click Next.

Wait while the installer copies software files to the computer and displays progress bars.

8 At the message indicating a successful installation, click Finish.

You can now start Acrobat and configure the recommended program settings, as described in 
the following procedure.
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TO CONFIGURE ACROBAT SETTINGS

NOTE: We recommend that you configurre the following settings when starting Acrobat for 
the first time. These are the recommended Acrobat settings for use with Impose.

1 Double-click the Acrobat program icon to start the application.

By default, the Acrobat program icon is located in C:\Program Files\Adobe\Acrobat 8.0. 
(The exact drive letter may vary, depending on the computer.)

2 At the License Agreement window, choose a language for displaying the agreement, and then 
click Accept.

3 At the Activate Adobe Acrobat 8 Standard window, do one of the following:

• To activate Acrobat over the Internet, click the Activate button. Wait for the activation 
process to finish.

• To activate Acrobat over the telephone, click “Other activation options.” Select “Over the 
Telephone,” and click OK to display the Phone Activation window. 

Call the telephone number listed for your location, and follow the voice instructions. 
When prompted, use the telephone keypad to enter the serial number and activation 
number listed in the Phone Activation window. Listen carefully for the authorization code, 
and enter it into the Authorization Code fields on the Phone Activation window. Click the 
Activate button to complete the activation process.

You must complete the activation process upon first starting Acrobat in order to use Acrobat 
with Impose. Do not choose the Activate Later option if it appears on the screen.

4 When the activation process is finished, click Done.

5 At the Getting Started window, select “Do not show at startup.” Then close the Getting 
Started window.

You can access the window later by choosing Getting Started from the Help menu.

6 Close the Acrobat application to save your configuration settings.

If the latest version of Command WorkStation is already installed on the computer, Impose is 
now fully enabled. If Command WorkStation is not yet installed, install Command 
WorkStation as described on page 17.
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Using Impose
Complete instructions on how to use Impose are provided in Command WorkStation, 
Windows Edition Help.

TO ACCESS IMPOSE HELP

1 Start Command WorkStation, Windows Edition.

2 Choose Help from the Help menu.

3 Use the Contents, Index, or Search panes to navigate to the Impose Help topics.
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PRODUCTION FEATURES

The Fiery Color Server offers additional production features for Fiery Color Server operators 
(or users with Operator or Administrator privileges) to monitor and manage the print 
workflow of jobs on the Fiery Color Server. All the features are accessible from Command 
WorkStation, Windows Edition. Schedule Printing is also accessible from Command 
WorkStation, Macintosh Edition. The features available are listed below:

• Compose (available as an option)

• Reorder Jobs

• Suspend on Mismatch

• Schedule Printing (also available from Command WorkStation, Macintosh Edition)

• Quick Doc Merge

Installing the production features
The additional production features are installed with Command WorkStation.

For information about installing Command WorkStation, Windows Edition, see “Installing 
Command WorkStation, Windows Edition” on page 17. For information about configuring 
Command Workstation, see “Configuring the connection to the Fiery Color Server” on 
page 18.

For information about installing Command WorkStation, Macintosh Edition, see “Installing 
Command WorkStation, Macintosh Edition” on page 38. For information about configuring 
Command Workstation, see “Configuring the connection to the Fiery Color Server” on 
page 38.

For complete instructions on how to use the standard Command WorkStation features, see 
Command WorkStation Help. For instructions on how to access Command WorkStation, 
Windows Edition Help, see “To access Command WorkStation Help” on page 21, and to 
access Command WorkStation, Macintosh Edition Help, see “To access Command 
WorkStation Help” on page 41.
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Using the production features
The following sections describe how to access and use the production features of the Fiery 
Color Server.

Compose

The Compose application allows you to define the chapter divisions of a job, print ranges of 
pages on varying types of media, insert blank media between pages, and insert tab media 
containing text labels. You can also preview the job as thumbnails and full screen previews, 
and edit documents using Acrobat and PitStop.

A special dongle must be installed on each computer that runs Compose. For more 
information about the dongle and installing it, see the document that accompanies the 
Compose kit.

To use Compose, you must also install Acrobat and PitStop on the client computer. Installers 
for Acrobat and PitStop are provided in the Compose kit. For information about installing 
Acrobat and PitStop, see the document that accompanies the Compose kit, or see “Installing 
Adobe Acrobat and Enfocus PitStop” on page 48.

For complete instructions on how to use Compose, see Compose Help. 

TO ACCESS COMPOSE AND COMPOSE HELP

1 Select a spooled/held job in the Active Jobs window and choose Compose from the Actions 
menu, or right-click the job and choose Compose from the menu that appears.

2 Choose Help from the Help menu.

If you have the Compose feature, we recommend that you use it instead of Mixed Media.
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Reorder Jobs

The Fiery Color Server processes and prints batches of selected jobs in the order of each job’s 
place in the queue. The Reorder Jobs feature allows you to control the processing or printing 
priority by reordering the job queue. When you promote jobs in the queue, these jobs take 
priority over the rest of the jobs on the Fiery Color Server. 

For example, you can reorder the queue to group jobs with similar print options, such as 
media or tray selections. When you select the jobs and apply the Print command, batches of 
jobs with similar options are printed together.

To reorder jobs, you must log in to the Fiery Color Server with Administrator privileges.

TO REORDER JOBS

1 Choose Reorder Jobs from the Server menu.

The Reorder Jobs dialog box appears.

2 Click the tab for the type of job that you want to reorder.

The Fiery Color Server supports the reordering of spooled/held jobs, processed/held jobs, and 
jobs that are waiting to process.

3 Select the job(s) that you want to reorder.

Hold down Ctrl and click to select multiple jobs. Hold down Shift and click to select a range 
of jobs.

4 Reorder the selected job(s).

To shift the job priority up or down, click the Move Up or Move Down button. To move the 
job(s) to top or bottom priority, click the Move to Top or Move to Bottom button. 

Jobs at the top of the list take priority over jobs at the bottom.

5 When you finish defining the order, click Done.
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Job Mismatch

When Job Mismatch is enabled, the Fiery Color Server detects if a job can print based on the 
media available on the copier. If the media is unavailable, the job is removed from the list of 
currently printing jobs so that other jobs can continue to print. 

Job Mismatch is enabled in Server Setup. For more information, see Configuration and Setup.

In setup, the Administrator can set Job Mismatch to do the following:

• Cancel a mismatched job so that the job moves to the Printed queue with an error 
describing the correct media to be loaded.

• Suspend a mismatched job so that the job is placed in a suspended state with an error 
describing the correct media to be loaded.

• Set a time-out that specifies how long the job waits for the media to be loaded.

Schedule Printing

The Schedule Printing feature allows you to set a specific date and time for printing a job. 
This feature is accessible from Command WorkStation on both Windows and Mac OS X 
computers. 

Assign Schedule Printing settings to a job from the following areas:

• Printer driver on a Windows computer only (see Print Options)

• Job Properties window in Command WorkStation

• Active Jobs window in Command WorkStation

Command WorkStation also allows you to search for jobs that have been scheduled for 
printing.

The procedures below describe accessing Schedule Printing from Command WorkStation, 
Windows Edition, and Command WorkStation, Macintosh Edition. 

TO SCHEDULE A JOB FOR PRINTING FROM THE ACTIVE JOBS WINDOW

1 Select a job in the Active Jobs window and choose Schedule Printing from the Actions menu.

2 In the dialog box that appears, specify the date and time when you want the job printed, and 
click OK.
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TO SCHEDULE A JOB FOR PRINTING FROM THE JOB PROPERTIES WINDOW

1 Select a job in the Active Jobs window and choose Properties from the Actions menu.

2 Click the Job Info icon and scroll down to Destination.

3 Select Schedule Printing, specify the date and time when you want the job printed, and 
click OK.

NOTE: Display the scheduled date and time by adding a Schedule Printing information 
column to the Active Jobs window. For information about adding information columns, see 
Command WorkStation Help.

TO FIND SCHEDULE PRINTING JOBS

1 Choose Find from the Edit menu.

2 Select Active Jobs.

3 Click the Advanced tab.

4 Scroll down and select Schedule Printing.

5 Click Find (Mac OS X) or Search (Windows).

6 To print the results of your search, click Print Window.

7 To save the results of your search, click Export Window, specify a file name, file name, and 
destination, and click Save.

8 Close the search results dialog.

NOTE: You can also search for scheduled jobs by using the Find Scheduled Jobs command in 
the Edit menu in Command WorkStation, Windows Edition. 

TO FIND SCHEDULED JOBS IN WINDOWS

1 Choose Find Scheduled Jobs from the Edit menu.

A window displays the search results.

2 To print the results of your search, click Print Window.

3 To save the results of your search, click Export Window, specify a file name and destination, 
and click Save.

4 Close the search results dialog.
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Quick Doc Merge

The Quick Doc Merge feature allows you to merge multiple files or jobs together so they can 
be printed as a single job on the Fiery Color Server.

Documents to be merged into one job in Quick Doc Merge must be either PostScript or PDF 
format. When merged into one job on the Fiery Color Server, the job becomes VDP format.

NOTE: When documents are merged into a Quick Doc Merge job, all Job Properties settings 
for the individual documents are overwritten and default to the Fiery Color Server default 
settings. So you must set Job Properties after you have combined the separate documents into 
the single Quick Doc Merge job.

TO USE QUICK DOC MERGE

1 To open Quick Doc Merge, select a job in the Active Jobs window and right-click, or choose 
Quick Doc Merge from the Actions menu.

The selected job is listed.
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Or choose File > Import > Import Quick Doc Merge.

No selected jobs are listed.

2 Click Add from Networks to browse and select PostScript or PDF files to import. 

Click Add from Fiery to display a list of all PostScript and PDF files in the Hold queue on the 
Fiery Color Server.

3 When the jobs you selected are listed, click Move Up or Move Down to change the order in 
which they are printed. Click Remove to remove a job.

4 Choose whether or not to select “Apply job properties to each job individually”.

This option applies to the job properties you set after creating and saving the Quick Doc 
Merge job. For more information, see “Applying job properties to Quick Doc Merge jobs” on 
page 58.

5 Type a name for the merged document in the “Save QDM job as” field.

6 Click Save.

The job is created and listed in the Active Jobs window. 

7 Specify job properties for the new Quick Doc Merge job.
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Applying job properties to Quick Doc Merge jobs
When a Quick Doc Merge job is created, any previous job properties set for the individual 
documents revert to the default Fiery Color Server settings. After creating and saving the 
Quick Doc Merge job, you must specify job properties for it. The option, “Apply job 
properties to each job individually”, applies to those job properties. 

If you select “Apply job properties to each job individually,” job properties are applied 
individually to each separate document that has been combined into the Quick Doc merge 
job. If you clear the option, job properties are applied to the Quick Doc Merge job as a single 
job. The settings that apply depending on whether this option is selected or not are described 
in the table below:

NOTE: When imposing a Quick Doc Merge job, Impose sets the page size for the entire job 
based on the first page of the Quick Doc Merge job. If the Quick Doc Merge job contains 
mixed page sizes, those pages with sizes different from the first page will be imposed as if they 
were the size of the first page (clipping performed as necessary).

“Apply job properties to each job individually” option

Selected Not selected

Finishing 
attributes

Applied individually to each separate 
document

Applied to the merged job as a single 
job

Duplex First page of each document is printed 
on the front side of the sheet

Duplex printing is continuous 
throughout the merged job

Mixed Media 
settings

Applied separately to each document in 
merged job

Applied to the merged job as s single 
job

Imposition Each document treated as a separate 
record of a VDP job

Merged document treated as a single 
record of VDP job



SCAN 59
SCAN

Scan is a collection of software components that allow you to scan documents from the copier 
glass or through the copier’s automatic document feeder (ADF) and send the scanned images 
to specific destinations. Scan consists of the following components:

• Remote Scan includes the TWAIN plug-in module. Remote Scan allows you to remotely 
retrieve a scan from a copier.

• Scan to E-mail allows you to send the scan file by e-mail as either an attachment or URL.

• Scan to FTP allows you to send the scan file to an FTP server.

• Scan to Internet Fax allows you to send the scan file to an e-mail address to be delivered as 
a fax.

• Scan to Mailbox allows you to send the scan to a mailbox on the Fiery Color Server, from 
where it can be retrieved.

• Scan to Hold queue allows you to scan to the Fiery Color Server Hold queue for document 
merging and editing.

• Docs WebTool allows you to retrieve scanned jobs from mailboxes on the Fiery Color 
Server.



SCAN 60
Installing and configuring Remote Scan
The following sections describe how to install and configure Remote Scan.

Installing Remote Scan

To install and use the Remote Scan application and TWAIN plug-in module, you must have a 
Windows or Mac OS computer with a network connection. For detailed system 
requirements, see Welcome.

The installer for Remote Scan is located on the User Software DVD.

To install Remote Scan, see “Installing user software on a Windows computer” on page 12 
and “Installing user software on a Mac OS computer” on page 14.

Configuring Remote Scan

The first time you start Remote Scan, you must configure the connection to the Fiery Color 
Server. Before you configure the connection, you must have the correct IP address. Make sure 
that the Fiery Color Server is registered in a Domain Name Server (DNS) on your network. 
When you open Remote Scan, the Scan Configuration dialog box appears. For instructions 
on configuring the connection to the Fiery Color Server for the first time, see “To configure 
the connection to the Fiery Color Server” on page 61.

Complete instructions on configuring and modifying the connection to the Fiery Color 
Server are provided in Remote Scan Help.

If you have previously configured a connection to the Fiery Color Server, it appears in the 
main Remote Scan window, and you can immediately start to initiate a scan or retrieve any 
scans initiated at the copier touch panel, and use Remote Scan Help.

TO ACCESS REMOTE SCAN HELP

1 Start Remote Scan or open the Remote Scan plug-in module.

2 Click the Help button.

3 Use the Contents, Index, or Search panes to navigate to the Remote Scan Help topics.
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TO CONFIGURE THE CONNECTION TO THE FIERY COLOR SERVER

1 When you start Remote Scan for first-time use, the Configuration window automatically 
appears. In the Server Name (or IP Address) text field, type the IP address or DNS name of 
the Print Server.

2 Select Use Nickname to enter another name to distinguish the Fiery Color Server. This name 
does not have to match the actual Server Name of the Fiery Color Server.

3 Type the name of the device (DC250 or DC260) connected to the Fiery Color Server. 

4 Click the green arrow to add the Fiery Color Server to My Fiery List. 

5 Click OK.

Using Remote Scan
With Fiery Remote Scan and the TWAIN plug-in module, you can retrieve scan files 
remotely by accessing a mailbox, which is set up in the Users and Groups section of WebTools 
Configure. You can open the scan file in a host application, such as Adobe Photoshop, and 
send the scan file to a mailbox, the Hold queue, or an e-mail address. All scans are stored on 
the Fiery Color Server hard disk and retrieved through the network.

Complete instructions on using Remote Scan and the TWAIN plug-in module are provided 
in Remote Scan Help. Although instructions are provided in Help for initiating scans from 
Remote Scan, this feature is not supported for the Fiery Color Server. Scanning is initiated at 
the copier touch panel. For more information, see the following section.



SCAN 62
Scanning from the copier
Scan jobs are initiated at the copier touch panel and either stored in a mailbox on the Fiery 
Color Server for remote retrieval or sent from the Fiery Color Server using e-mail, Internet 
Fax, FTP, or SMB. Scan jobs can be retrieved from a mailbox using the Docs WebTool or the 
Remote Scan application.

The Fiery Color Server uses Scan Settings, or scan templates, to determine how to scan a 
document and where to send it. Each scan template is listed in the Network Scanning area of 
the copier touch panel. To scan a document, you must use one of the scan templates listed at 
the copier touch panel. A number of default scan templates are provided with the Fiery Color 
Server. You can modify a duplicated scan template at the copier touch panel, or create a new 
scan template in WebTools Scan Settings.

Scanning workflows

Any user can initiate a scan at the copier by choosing one of the default scan templates listed 
in the Network Scanning area of the copier touch panel. The scan can then be retrieved from 
the “guest” mailbox using WebTools Docs or the Remote Scan application. Several default 
scan templates are available, some of which are locked and some of which are editable. For 
more information, see “Default Scan Settings” on page 63.

You can specify a different destination for a default editable scan template in the Scan tab of 
the Web Applications area of the copier touch panel, and save it as a new scan template. You 
can then select this new scan template from the list in the Network Scanning area of the 
copier touch panel. For more information, see “Modifying Scan Settings at the copier” on 
page 65.

The Fiery Color Server administrator can create in WebTools Scan Settings a custom scan 
template that other users cannot edit. The administrator can assign ownership of this new 
scan template to an existing user. Either the administrator or the user who owns the scan 
template can define the document settings and destinations for it. It can then be selected from 
the list in the Network Scanning area of the copier touch panel. 

Mailboxes for scan jobs are set up in WebTools Configure Users and Groups by the 
administrator. The administrator belongs to the “admin” group. Guest and Operator are also 
default groups on the Fiery Color Server. A mailbox is set up by adding user names to a group 
with Fiery Mailbox Privileges. The administrator can also add users from an LDAP address 
book. Administrators can view and manage all Scan Settings templates, including deleting 
templates, and changing the user name/mailbox for a specific Scan Settings template. 
Administrators can also view all mailboxes in WebTools Docs and manage the scans sent to 
mailboxes.

NOTE: To log in as Administrator to WebTools Docs and Scan Settings, you must type the 
user name as “admin”.
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Default Scan Settings

To initiate a scan from the copier touch panel, you choose a scan settings template. The Fiery 
Color Server comes with several default scan settings templates that you can select at the 
copier touch panel. 

Default locked templates that cannot be changed are:

• (ColorCal): for calibrating the Fiery Color Server

• (bw): for black-and-white documents

• (color): for color documents

• (grayscale): for grayscale documents, such as black-and-white photographs

Default guest templates that can be edited are:

• COLOR0GUEST

• GRAYSCALE0GUEST

• BW0GUEST

You can create a new template based on one of the default guest templates by renaming it and 
modifying it at the copier or by modifying it in WebTools Scan Settings. You can change the 
destinations either at the copier or in WebTools Scan Settings. You can modify document 
settings in WebTools Scan Settings. 

NOTE: You cannot change the color mode setting when you are creating a scan template based 
on either one of the Fiery Color Server default guest templates or on a template you created in 
WebTools Scan Settings.

For information about setting up scan templates, see WebTools Scan Settings Help and 
“Modifying Scan Settings in WebTools” on page 67.

For information about setting up users and mailboxes, see WebTools Configure Help.
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Scanning with default scan settings

When you initiate a scan from the copier, you select a scan settings template from the list 
displayed on the copier touch panel. 

TO SCAN A DOCUMENT FROM THE COPIER

1 Press the All Services icon at the upper-right corner of the copier touch panel.

2 Press Network Scanning.

3 Select the template that you want to use. 

All Scan Settings templates are displayed.

4 If desired, select options in the General Settings pane, and also in the Image Quality, Layout 
Adjustment, and Output Format panes.

NOTE: You cannot change color mode settings for any of the default templates or templates 
created from them.

When you select options in the Image Quality, Layout Adjustment, and Output Format 
panes, you must click Save. Any document settings selected at the copier touch panel before 
scanning a document are only saved and applied for the scan you are performing. After the 
scan is completed, the settings revert to the original settings for that scan template.

For more information about document settings on the copier, see the documentation that 
accompanies your copier.

5 Press the green Start button on the front of the copier.

6 To retrieve your scan, use Remote Scan or WebTools Docs.

NOTE: The default mailbox for all default Scan Settings is guest.
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Modifying Scan Settings at the copier

All users can modify the guest-owned scan settings at the copier. When you choose a scan 
template in the Web Applications area of the copier touch panel, you can rename the template 
to create a new template, and then edit any of the scan settings’ destinations

When you use a default template as a basis for creating a new template, you cannot change the 
scan color of the original template. So you should choose the template to use as your basis by 
the color: color, black-and-white, or grayscale.

TO MODIFY A SCAN TEMPLATE ON THE COPIER TOUCH PANEL

1 Press the All Services icon at the upper-right corner of the copier touch panel.

2 Press Web Applications.

3 Press the Scan tab.

NOTE: Only the guest-owned scan settings are displayed. “Guest-owned” means that they have 
been created under the user name of “guest”, and the scans are sent to the guest mailbox.

4 If you want to change the destination mailbox for one of the guest-owned scan settings, you 
must log in as Administrator. 

To do so, click Login, select Administrator, and type the Administrator password.

5 Select a scan settings template.

6 To view the destination settings for a scan template, press the two arrows to the left of the 
scan template name. 

The scan destinations designated for that template are displayed.

7 To view the document settings for the template, press the arrow at the top right of the 
window.

The Document Settings are displayed.

8 Click OK to return to the Scan Templates page.

9 To create a scan template, press the Edit button for the template that you want to use as the 
basis.

10 Type a new name in the Name field for the Scan Settings.

The user name for all scan templates displayed in Web Applications on the copier touch panel 
is guest and cannot be changed by users with guest access. If you log in as Administrator, you 
can change the user name. As the Administrator, you can also change the user name in 
WebTools Scan Settings.

NOTE: The new scan template name must consist only of uppercase letters and numbers. 
Lowercase letters and special characters are not allowed.

11 If desired, type a description in the Description field.
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12 Select one of the following destinations:

• Mailbox allows you to send the scan file to a Mailbox that you select in WebTools Scan 
Settings. You must set up the Mailbox first as a user of a group in WebTools Configure 
Users and Groups that has mailbox privileges. The default mailboxes are: admin, operator, 
and guest.

• E-mail allows you to send the scan file via e-mail. In Setup, the administrator determines 
the maximum allowed size of the attachment. If the attachment size exceeds this 
maximum, the Fiery Color Server sends it as a URL. For more information, see 
Configuration and Setup.

• Internet Fax allows you to send the scan file by e-mail via a fax server to an analog fax 
machine. The scan is converted to Internet Fax format. When you send a scan to Internet 
Fax, type the address in e-mail format. 

• FTP allows you to send the scan file to an FTP site. If a Proxy Server has been enabled by 
the Fiery Color Server Administrator in Setup, ask the Administrator for the Proxy 
Address. You may be required to type a user name and password. If the user name is 
displayed as blank, an anonymous login is allowed, and you do not have to type a 
password.

• SMB allows you to send the scan file to any network folder or computer on the network 
using SMB. You must know the domain, the computer name (server name), and the 
shared folder for the destination computer to send a file using SMB. You are required to 
type a user name and password. If a password is required, but not entered, no error 
message is displayed, and the scan file is not sent to the destination. It may be that a 
password was not required. Check with your network administrator for the login 
requirements for any SMB connection on your network. 

13 Press Save Changes.

The new scan template you have just created appears in the list of templates.

14 Press the All Services icon at the upper-right corner of the copier touch panel.

After you have created your new template on the copier touch panel, you can specify 
document settings on the copier touch panel and initiate the scan.
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Modifying Scan Settings in WebTools

When you log into Scan Settings you can view all scan templates associated with your user 
name. You must have Fiery Color Server mailbox privileges and can only modify scan 
template files to which you have access.

The administrator has full access to all scan templates. In addition, the administrator can 
create new scan templates in Scan Settings and can import and export scan templates. The 
procedure below is for all users.

TO MODIFY SCAN SETTINGS IN WEBTOOLS

1 Start your Internet browser. 

2 Type the IP address or DNS name of the Fiery Color Server.

3 Click the Scan Settings tab.

4 Log in to Scan Settings.

To log in as guest, you do not need to type a password. To log in as an Administrator, you 
must type “admin” in the User Name field and type the Administrator password, if required.

5 Select the scan template that you want to edit and click Edit.

6 Specify the following General Setting options for your scan template:

• Name: Specify the name to display on the copier touch panel and in the list of Scan 
Settings.

• Description: Type a description of your scan template to allow users to identify the scan 
template at the print engine scan initiation screen.

• Username: Specify the owner name of the scan template. When you log in to Scan 
Settings, only scan templates display that match your user name and your login user name. 

This option can only be edited by an administrator. The administrator can specify any 
Fiery Color Server user that has mailbox rights (including local Fiery Color Server users, 
LDAP users, and members of LDAP groups that have mailbox privileges). 

7 Specify Scan Destination options for your scan template.

8 Specify Document Settings options for your scan template.

9 Specify Scan Enhancement options for your scan template.

10 To save your scan template, click Save.

At least one scan destination must be specified to save the scan template.

11 To cancel your changes and return to the main Scan Settings window, click Cancel.

12 To revert changes you have made to the scan template, click Reset.
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Creating Scan Settings in WebTools

Scan Settings allows users with administrator access to create new scan templates in Scan 
Settings, in addition to editing scan templates. Administrators can also delete scan templates 
and change user names for a scan settings template.

TO CREATE A NEW SCAN TEMPLATE IN WEBTOOLS

1 Start your Internet browser. 

2 Type the IP address or DNS name of the Fiery Color Server.

3 Click the Scan Settings tab.

4 Log in to Scan Settings.

To log in as an Administrator, you must type “admin” in the User Name field and type the 
Administrator password, if required.

5 Click the New icon.

6 Specify the settings for your scan template.

7 To save your scan settings, click Save.

Retrieving scans

You can retrieve scans from a mailbox using WebTools Docs or Remote Scan. For information 
about Remote Scan, see “Using Remote Scan” on page 61. For information about using 
WebTools, see page 76.
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HOT FOLDERS

Hot Folders is a utility that allows you to store and reuse frequently used print options when 
printing PostScript and PDF files on the Fiery Color Server. With Hot Folders, you can do 
the following:

• Create special folders (hot folders) that assign specific print settings and print queues 
to jobs

• Print jobs to the Fiery Color Server by dragging and dropping them onto hot folders on 
your computer’s desktop

• Monitor the status of jobs sent to hot folders

Installing Hot Folders
The installer for Hot Folders is located on the User Software DVD.

Before installing the utility, make sure you complete the preliminary procedures described on 
page 10 and page 11.

To install Hot Folders on a Windows computer, see “Installing user software on a Windows 
computer” on page 12. To install Hot Folders on a Mac OS computer, see “Installing user 
software on a Mac OS computer” on page 14.

Using Hot Folders
Complete instructions on how to use the standard Hot Folders features are provided in Hot 
Folders Help.

If the Graphic Arts Package, Premium Edition is installed and enabled on the Fiery Color 
Server, you can use additional file format filters with Hot Folders. For information about 
using these file format filters, see Graphic Arts Package. 

TO ACCESS HOT FOLDERS HELP

1 Start Hot Folders.

2 Choose Help  >  EFI Hot Folders Help.
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Additional features
The following section describes additional features of Hot Folders that is not discussed in Hot 
Folders Help.

Preserve Document Setting

When you define Job Settings for a new Hot Folder and open the Job Properties window, the 
default for many settings is displayed as Preserve Document Setting. This setting allows you 
to keep the job properties you set when creating the original job in the application.

About Hot Folders filters

Hot Folders filters allow you to convert certain file formats to PostScript or PDF or to 
preflight files for conformity. File conversion and preflighting take place on your computer 
within Hot Folders, which saves Fiery Color Server resources. You can print files directly from 
Hot Folders filters without starting the application from which they were created.

Using the PDF to PS filter

The PDF to PS filter is standard. The PDF to PS filter accepts PDF (v1.2 through v1.6) files 
and outputs PostScript files. 

NOTE: The filter converts any PDF v1.2 files to PDF v1.6 files, and then to PostScript Level 3 
files before submitting to the Fiery Color Server.

Microsoft Office filters for Hot Folders

The Microsoft Office filters for Hot Folders feature allows you to convert certain MS Office 
file formats to PostScript. File conversion takes place on your computer within Hot Folders, 
which saves Fiery Color Server resources. You can print files directly from Hot Folders filters 
without starting the application from which they were created.

The Microsoft Office filters have no configurable options; however, you must have the 
following versions of each application, and have a PostScript printer or Acrobat Distiller 
installed to convert the files to PostScript files.

• Microsoft Excel 2000 or later

• Microsoft Publisher 2002 or later

• Microsoft PowerPoint 2000 or later

• Microsoft Word 2000 or later
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Specifying filter settings for a Hot Folder

After specifying the filter settings and options for your Hot Folder, drag and drop the proper 
file formats onto your Hot Folder to begin the conversion process.

Open the Filter Settings dialog box from the Folder Properties dialog box.

TO SELECT A FILTER SETTING

1 From the Hot Folders Control Panel, select the Hot Folder and click Properties.

2 Select Filter Settings and click Define.

The Filter Settings dialog box appears, allowing you to select the filter. 

For Windows, filters are color-coded. Exclusive filters are blue and Non-exclusive filters are 
black. 

If you select an Exclusive filter, you cannot select any other filter. Microsoft Office filters are 
non-exclusive filters, so you can select as many of them as you wish.

3 To convert all PostScript files to PDF automatically, select Convert PS to PDF and a job option 
from the Distiller Profile menu in the PS->PDF Normalizer pane.

4 Click OK.
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VDP RESOURCE MANAGER

VDP Resource Manager allows you to do the following:

• Search for global objects used in variable data printing

• Delete global objects used in variable data printing

Installing VDP Resource Manager
To install and use VDP Resource Manager, you must have a Windows or Mac OS computer 
that can connect to the Fiery Color Server. For detailed system requirements, see Welcome.

The installer for VDP Resource Manager is located on the User Software DVD.

Before installing the utility, complete the preliminary procedures described in “Preparing for 
installation on Windows computers” on page 10 and “Preparing for installation on Mac OS 
computers” on page 11.

To install VDP Resource Manager on a Windows computer, see “Installing user software on a 
Windows computer” on page 12. To install VDP Resource Manager on a Mac OS computer, 
see “Installing user software on a Mac OS computer” on page 14.
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Configuring the connection to the Fiery Color Server
The first time you start VDP Resource Manager, you must configure the connection to the 
Fiery Color Server.

NOTE: The Windows and Mac OS versions of VDP Resource Manager are similar. The 
following illustrations show the Windows version. 

BEFORE YOU BEGIN

• Print the Fiery Color Server Configuration page. 

For instructions on printing the Configuration page, see Configuration and Setup.

This page contains information you need when configuring the connection, such as the IP 
address of the Fiery Color Server. For TCP/IP installations, you can use the DNS name 
instead of the IP address. Make sure that the Fiery Color Server is already registered in a 
Domain Name Server (DNS) on your network. For more information, see the 
documentation that accompanies your network system. 

TO CONFIGURE THE CONNECTION FOR FIERY VDP RESOURCE MANAGER

1 Click Start, choose Programs, and then click Fiery VDP Resource Manager in the Fiery folder.

The Available Servers dialog box appears, with all Fiery Color Server servers in the local 
subnet displayed.
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2 To locate a server by its IP address, click the Manual tab, type the IP address, and then 
click Add.

The server appears in the Available Servers dialog box.

3 To locate the Fiery Color Server either by a range of IP addresses or by the IP address and 
subnet mask, click the Auto Search tab, and then click Advanced.

4 Click the IP Range tab or the Subnet tab.

5 To search by a range of IP addresses, enter the information in the From IP and To IP fields, 
click Add, and then click Search.

To search by IP address and subnet mask, enter the information in the From IP and Subnet 
fields, click Add, and then click Search.

All available servers are displayed in the Available Servers dialog box.

6 Select the servers that you want and click Add.

All connected servers are displayed in the Fiery Servers list in the Fiery VDP Resource 
Manager dialog box.
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TO MODIFY THE CONFIGURATION FOR FIERY VDP RESOURCE MANAGER

1 Click Start, choose Programs, and then click Fiery VDP Resource Manager in the Fiery folder.

All servers you connected to previously are displayed.

2 To remove a server, select the server that you want to remove, and then choose Disconnect 
from the Server menu.

3 To add a server, choose Connect from the Server menu and follow the procedure 
“To configure the connection for Fiery VDP Resource Manager” on page 73.

Using VDP Resource Manager
Complete instructions on how to use VDP Resource Manager are provided in VDP Resource 
Manager Help. 

TO ACCESS VDP RESOURCE MANAGER HELP

1 Launch VDP Resource Manager.

2 Choose Help  >  Fiery VDP Resource Manager Help.
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WEBTOOLS

WebTools allow you to manage your Fiery Color Server remotely from the Internet or your 
company’s intranet. The Fiery Color Server has its own home page, where you can select the 
following WebTools:

• Home provides current information about the jobs processing and printing on the Fiery 
Color Server.

• Downloads allows remote users to download installers (for drivers, PPDs, and other 
software) directly from the Fiery Color Server.

• Docs allows remote users to access jobs on the Fiery Color Server over the Internet or 
intranet. 

• Configure allows the Fiery Color Server administrator to view and modify Setup options 
remotely from a Windows computer.

• Scan Settings allows the Fiery Color Server administrator to create Scan Templates.

Setting up WebTools
WebTools are resident on the Fiery Color Server hard disk and do not require special 
installation. However, WebTools do require initial setup by the Fiery Color Server 
administrator.

To enable network users to access and use WebTools, the administrator must set specific 
options in Network Setup and Printer Setup. For information about these specific Setup 
options, see Configuration and Setup.

The administrator also must prepare each user’s computer to communicate with the Fiery 
Color Server over the Internet or intranet.
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TO SET UP CLIENT COMPUTERS TO USE WEBTOOLS

1 Enable TCP/IP networking.

2 Make sure that the computer has a valid, unique IP address.

3 Make sure that a supported Internet browser is installed on the computer.

For more information about supported browsers, see Welcome.

4 Make sure that Java is enabled in your Internet browser.

In addition, make sure that you have completed the preliminary procedures described in 
“Preparing for installation on Windows computers” on page 10.

NOTE: If the client computer is running Windows XP with Service Pack 2 (SP2) installed, 
Pop-up Blocker is turned on by default. With this function turned on, a warning message 
appears when you access WebTools, and your access to WebTools is denied. To gain access, do 
one of the following:

• Change the Pop-up Blocker setting by clicking the warning message and choosing from 
one of the selections that appears.

• Turn off Pop-up Blocker in Internet Explorer from the Tools menu or in Internet Options.

For more information, see Internet Explorer Help, or the documentation that accompanies 
Windows.

Accessing the WebTools home page
Use your Internet browser to access WebTools. For complete information about browser and 
system requirements, see Welcome.

TO ACCESS THE WEBTOOLS HOME PAGE

1 Start your Internet browser. 

2 Type the IP address or DNS name of the Fiery Color Server.

The Fiery Color Server home page appears. 

If the home page for the copier appears instead of the WebTools page, click the WebTools 
link.

3 Click the tab for the WebTool that you want to use.
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Using WebTools
The following sections describe how to use the WebTools.

Home

Home lets you view jobs that are currently processing and printing on the Fiery Color Server. 
Printing and processing information is updated every 30 seconds.

For complete instructions on how to use Home, see WebTools Home Help. 

Downloads

The Downloads WebTool allows you to download installers (for drivers, PPDs, and other 
Fiery Color Server software) directly from the Fiery Color Server.

For complete instructions on how to use Downloads, see WebTools Downloads Help. 

Docs

Docs allows you to access jobs on the Fiery Color Server over the Internet or intranet. You 
can: 

• Manage and distribute jobs in your mailbox. 

Mailboxes are set up in the Users and Groups area of the Configure WebTool.

• Control and modify jobs.

• Submit jobs to the Print Server.

For complete instructions on how to use Docs, see WebTools Docs Help. 

Configure

Configure allows the Fiery Color Server administrator to view and modify Setup options 
remotely from a Windows computer. For information about using Configure, see 
Configuration and Setup. 

Before using Configure, make sure you have completed the Configure preparation procedure 
described in “Preparing for installation on Windows computers” on page 10.

For complete instructions on how to use Configure, see WebTools Configure Help. 
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Scan Settings

Scan Settings allows the Fiery Color Server administrator to set up Scan Templates. These 
scan templates are accessible from the copier touch panel, by pressing either Network 
Scanning or Web Applications. The Network Scanning copier touch panel displays the 
default copier scan templates, as well as any that have been set up through WebTools Scan 
Settings. 

TO CREATE A SCAN TEMPLATE

1 On the WebTools Home page, click the Scan Settings tab.

2 Log in as Administrator. 

Only Administrators can create Scan Templates.

3 Click the New icon.

4 In the General Settings area, enter a name for your new scan template and, if desired, a 
description.

5 In the Scan Destination area, select the destinations you want and enter the required 
information.

You can send a scan to a Mailbox, E-Mail, FTP server, or SMB location.

6 In the Document Settings and Scan Enhancements areas, select your choices from the menus 
for each option.

7 Click Save. To reset the defaults, click Reset.

The newly created Scan Template appears on the copier touch panel. 

For complete instructions on how to use Scan Settings, see WebTools Scan Settings Help. 
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